# Contents at a Glance

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pivot Table Fundamentals</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>Creating a Basic Pivot Table</td>
<td>17</td>
</tr>
<tr>
<td>3</td>
<td>Customizing a Pivot Table</td>
<td>45</td>
</tr>
<tr>
<td>4</td>
<td>Grouping, Sorting, and Filtering Pivot Data</td>
<td>75</td>
</tr>
<tr>
<td>5</td>
<td>Performing Calculations Within Your Pivot Tables</td>
<td>113</td>
</tr>
<tr>
<td>6</td>
<td>Using Pivot Charts and Other Visualizations</td>
<td>135</td>
</tr>
<tr>
<td>7</td>
<td>Analyzing Disparate Data Sources with Pivot Tables</td>
<td>157</td>
</tr>
<tr>
<td>8</td>
<td>Sharing Pivot Tables with Others</td>
<td>185</td>
</tr>
<tr>
<td>9</td>
<td>Working with and Analyzing OLAP Data</td>
<td>193</td>
</tr>
<tr>
<td>10</td>
<td>Mashing Up Data with PowerPivot</td>
<td>215</td>
</tr>
<tr>
<td>11</td>
<td>Dashboarding with PowerView</td>
<td>261</td>
</tr>
<tr>
<td>12</td>
<td>Enhancing Your Pivot Table Reports with Macros</td>
<td>281</td>
</tr>
<tr>
<td>13</td>
<td>Using VBA to Create Pivot Tables</td>
<td>295</td>
</tr>
<tr>
<td>14</td>
<td>Advanced Pivot Table Tips and Techniques</td>
<td>359</td>
</tr>
<tr>
<td>15</td>
<td>Dr. Jekyll and Mr. GetPivotData</td>
<td>383</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>401</td>
</tr>
</tbody>
</table>
# Contents

## Introduction ................................................................................................................. 1
- What You Will Learn from This Book ......................................................................... 1
- What Is New in Excel 2013’s Pivot Tables ................................................................. 2
- Skills Required to Use This Book ................................................................................ 2
- Invention of the Pivot Table .......................................................................................... 4
- Sample Files Used in This Book ................................................................................. 7
- Conventions Used in This Book ................................................................................... 7
  - Referring to Versions ................................................................................................. 7
  - Referring to Ribbon Commands ............................................................................... 7
  - Special Elements ....................................................................................................... 8

## 1 Pivot Table Fundamentals ......................................................................................... 9
- What Is a Pivot Table? .................................................................................................. 9
- Why Should You Use a Pivot Table? ........................................................................... 10
- When Should You Use a Pivot Table? ........................................................................ 11
- The Anatomy of a Pivot Table ...................................................................................... 12
  - Values Area ............................................................................................................... 12
  - Rows Area .................................................................................................................. 13
  - Columns Area ........................................................................................................... 13
  - Filters Area ............................................................................................................... 14
- Pivot Tables Behind the Scenes ................................................................................... 14
- Limitations of Pivot Table Reports .............................................................................. 15
  - A Word About Compatibility .................................................................................... 15
- Next Steps .................................................................................................................... 16

## 2 Creating a Basic Pivot Table ...................................................................................... 17
- Preparing Your Data for Pivot Table Reporting .......................................................... 17
- Ensure Your Data Is in a Tabular Layout ..................................................................... 18
- Avoid Storing Data in Section Headings ..................................................................... 18
- Avoid Repeating Groups as Columns ......................................................................... 19
- Eliminate Gaps and Blank Cells in Your Data Source ................................................. 20
- Apply Appropriate Type Formatting to Your Fields .................................................. 20
- Summary of Good Data Source Design ..................................................................... 20
- Creating a Basic Pivot Table ......................................................................................... 22
  - Adding Fields to the Report ..................................................................................... 25
  - Adding Layers to Your Pivot Table ......................................................................... 27
  - Rearranging Your Pivot Table .................................................................................. 28
  - Creating a Report Filter ............................................................................................ 29
- Understanding the Recommended Pivot Tables Feature ............................................ 30
4 Grouping, Sorting, and Filtering Pivot Data .................................................................75
  Grouping Pivot Fields ...................................................................................................... 76
  Including Years When Grouping by Months ................................................................. 77
  Grouping Date Fields by Week ...................................................................................... 78
  Ungrouping .................................................................................................................. 79
  Grouping Numeric Fields .............................................................................................. 79
  Using the PivotTable Fields List .................................................................................... 83
  Docking and Undocking the PivotTable Fields List ...................................................... 85
  Rearranging the PivotTable Fields List .......................................................................... 85
  Using the Areas Section Drop-Downs ........................................................................... 86
  Filtering the Pivot Table: An Overview .......................................................................... 94
  Using Filters for Row and Column Fields ...................................................................... 95
    Filtering Using the Check Boxes ................................................................................ 95
    Filtering Using the Search Box .................................................................................. 96
    Filtering Using the Label Filters ............................................................................... 97
    Filtering a Label Column Using Information in a Values Column ................................ 99
    Creating a Top-Five Report Using the Top 10 Filter ................................................ 100
    Filtering Using the Date Filters in the Label Drop-Down .......................................... 102
    Filter Using the Filters Area .................................................................................... 103
      Adding Fields to the Filters Area ........................................................................... 103
      Choosing One Item from a Filter .......................................................................... 104
      Choosing Multiple Items from a Report Filter ....................................................... 104
      Replicating a Pivot Table Report for Each Item in a Filter .................................... 104
    Filtering Using Slicers and Timelines ........................................................................ 106
      Using Timelines to Filter by Date ........................................................................ 108
      Driving Multiple Pivot Tables from One Set of Slicers .......................................... 109
      Next Steps .............................................................................................................. 111

5 Performing Calculations Within Your Pivot Tables ....................................................113
  Introducing Calculated Fields and Calculated Items ....................................................113
    Method 1: Manually Add the Calculated Field to Your Data Source ..........................114
    Method 2: Use a Formula Outside Your Pivot Table to Create the Calculated Field ... 115
    Method 3: Insert a Calculated Field Directly into Your Pivot Table ..........................116
  Creating Your First Calculated Field ..........................................................................116
  Creating Your First Calculated Item ..........................................................................124
  Understanding the Rules and Shortcomings of Pivot Table Calculations ....................128
Removing a Table from the Data Model ................................................................. 172
Create a New Pivot Table Using the Data Model .................................................... 173
Limitations of the Internal Data Model ................................................................. 174
Building a Pivot Table Using External Data Sources ............................................ 175
Building a Pivot Table with Microsoft Access Data ............................................ 175
Building a Pivot Table with SQL Server Data ..................................................... 178
What’s Next ........................................................................................................... 184

8 Sharing Pivot Tables with Others ....................................................................... 185
Designing a Workbook as an Interactive Web Page .............................................. 186
Sharing a Link to Your Web Workbook ............................................................... 188
Embedding Your Workbook in a Blog Post or Your Web Page ............................. 189
Sharing Pivot Tables with Other Versions of Office ............................................. 192

9 Working with and Analyzing OLAP Data ......................................................... 193
What Is OLAP? ....................................................................................................... 193
Connecting to an OLAP Cube .............................................................................. 194
Understanding the Structure of an OLAP Cube .................................................. 197
Understanding the Limitations of OLAP Pivot Tables ........................................ 199
Creating Offline Cubes ........................................................................................ 199
Breaking Out of the Pivot Table Mold with Cube Functions ................................ 202
Adding Calculations to Your OLAP Pivot Tables ................................................. 204
Creating Calculated Measures ............................................................................ 205
Creating Calculated Members ............................................................................. 208
Managing Your OLAP Calculations ..................................................................... 210
Performing What-If Analysis with OLAP Data .................................................... 211
Next Steps ............................................................................................................ 213

10 Mashing Up Data with PowerPivot ................................................................. 215
Understanding the Benefits and Drawbacks of PowerPivot and the Data Model ......................................................................................... 215
Import 100 Million Rows into Your Workbook .................................................. 216
Create Better Calculations Using the DAX Formula Language ......................... 216
Other Benefits of the PowerPivot Data Model in All Editions of Excel ............... 216
Benefits of the Full PowerPivot Add-In with Excel Pro Plus ............................... 217
Understanding the Limitations of the Data Model ............................................. 217
Joining Multiple Tables Using the Data Model in Regular Excel 2013 ................. 218
Preparing Data for Use in the Data Model .......................................................... 219
Adding the First Table to the Data Model ........................................................... 220
Adding the Second Table and Defining a Relationship ....................................... 221
Tell Me Again—Why Is This Better Than Doing a VLOOKUP? ........................... 223
### Dashboarding with Power View

#### Preparing Your Data for Power View
- Creating a New Pivot Table from an Existing Data Model
- Getting a Distinct Count
- Using the PowerPivot Add-In from Excel 2013 Pro Plus
- Enabling PowerPivot
- Import a Text File
- Add Excel Data by Copying and Pasting
- Add Excel Data by Linking
- Define Relationships
- Add Calculated Columns Using DAX
- Build a Pivot Table
- Understanding Differences Between PowerPivot and Regular Pivot Tables
- Two Kinds of DAX Calculations
- DAX Calculations for Calculated Columns
- Using RELATED ( ) to Base a Column Calculation on Another Table
- Using DAX to Create a Calculated Field in the Pivot Table
- DAX Calculated Fields Implicitly Respect the Filters
- Define a DAX Calculated Field
- Is Unfilter Even a Word?
- CALCULATE Is a Super-Enhanced Version of SUMIFS
- Adding Fields to the Values Area Generates DAX Calculated Fields
- Using a Calendar Table to Enable Time Intelligence Functions
- Adding the Data to PowerPivot and Formatting It
- PowerPivot Doesn’t Automatically Sort by Custom Lists
- Create a PivotTable and Marvel at the Results
- This Is a Discussion About Time Intelligence
- Using Key Performance Indicators
- Setting up a KPI Compared to an Absolute Value
- Setting Up a KPI Compared to a Calculated Target Value
- Other Issues
- Combination Layouts
- Getting Your Data into PowerPivot with SQL Server
- Other Issues
- Next Steps

#### Using DAX Calculations for Calculated Columns
- Define a DAX Calculated Field
- DAX Calculated Fields Implicitly Respect the Filters
- Using DAX to Create a Calculated Field in the Pivot Table
- Adding Fields to the Values Area Generates DAX Calculated Fields

#### PowerPivot Doesn’t Automatically Sort by Custom Lists
- Adding the Data to PowerPivot and Formatting It
- This Is a Discussion About Time Intelligence

#### Using Key Performance Indicators
- Setting up a KPI Compared to an Absolute Value
- Setting Up a KPI Compared to a Calculated Target Value

#### Combination Layouts
- Getting Your Data into PowerPivot with SQL Server
- Other Issues

#### Next Steps
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 Enhancing Your Pivot Table Reports with Macros</td>
<td>281</td>
</tr>
<tr>
<td>Why Use Macros with Your Pivot Table Reports?</td>
<td>281</td>
</tr>
<tr>
<td>Recording Your First Macro</td>
<td>281</td>
</tr>
<tr>
<td>Creating a User Interface with Form Controls</td>
<td>284</td>
</tr>
<tr>
<td>Altering a Recorded Macro to Add Functionality</td>
<td>286</td>
</tr>
<tr>
<td>What’s Next</td>
<td>294</td>
</tr>
<tr>
<td>13 Using VBA to Create Pivot Tables</td>
<td>295</td>
</tr>
<tr>
<td>Enabling VBA in Your Copy of Excel</td>
<td>295</td>
</tr>
<tr>
<td>Using a File Format That Enables Macros</td>
<td>296</td>
</tr>
<tr>
<td>Visual Basic Editor</td>
<td>297</td>
</tr>
<tr>
<td>Visual Basic Tools</td>
<td>298</td>
</tr>
<tr>
<td>The Macro Recorder</td>
<td>298</td>
</tr>
<tr>
<td>Understanding Object-Oriented Code</td>
<td>299</td>
</tr>
<tr>
<td>Learning Tricks of the Trade</td>
<td>299</td>
</tr>
<tr>
<td>Writing Code to Handle Any Size Data Range</td>
<td>299</td>
</tr>
<tr>
<td>Using Super-Variables: Object Variables</td>
<td>300</td>
</tr>
<tr>
<td>Using With and End With to Shorten Code</td>
<td>301</td>
</tr>
<tr>
<td>Understanding Versions</td>
<td>301</td>
</tr>
<tr>
<td>Code for New Features Won’t Work in Previous Versions</td>
<td>302</td>
</tr>
<tr>
<td>Building a Pivot Table in Excel VBA</td>
<td>302</td>
</tr>
<tr>
<td>Adding Fields to the Data Area</td>
<td>304</td>
</tr>
<tr>
<td>Formatting the Pivot Table</td>
<td>305</td>
</tr>
<tr>
<td>Dealing with Limitations of Pivot Tables</td>
<td>307</td>
</tr>
<tr>
<td>Filling Blank Cells in the Data Area</td>
<td>307</td>
</tr>
<tr>
<td>Filling Blank Cells in the Row Area</td>
<td>307</td>
</tr>
<tr>
<td>Learning Why You Cannot Affect a Pivot Table by Inserting or Deleting Cells</td>
<td>308</td>
</tr>
</tbody>
</table>
Tip 5: Fill the Empty Cells Left by Row Fields .................................................................................................362
  Option 1: Implement the Repeat All Data Items Feature ..........................................................363
  Option 2: Use Excel’s Go To Special Functionality ...............................................................................364
Tip 6: Add a Rank Number Field to Your Pivot Table ................................................................................365
Tip 7: Reduce the Size of Your Pivot Table Reports ....................................................................................366
  Delete Your Source Data Tab .................................................................................................................367
Tip 8: Create an Automatically Expanding Data Range ............................................................................367
Tip 9: Compare Tables Using a Pivot Table .................................................................................................368
Tip 10: AutoFilter a Pivot Table ................................................................................................................370
Tip 11: Transpose a Data Set with a Pivot Table .......................................................................................371
  Step 1: Combine All Non-Column-Oriented Fields into One Dimension Field ............................371
  Step 2: Create a Multiple Consolidation Ranges Pivot Table .........................................................372
  Step 3: Double-Click the Grand Total Intersection of Row and Column. ...................................372
  Step 4: Parse Your Dimension Column into Separate Fields ...........................................................373
Tip 12: Force Two Number Formats in a Pivot Table .................................................................................374
Tip 13: Create a Frequency Distribution with a Pivot Table ....................................................................376
Tip 14: Use a Pivot Table to Explode a Data Set to Different Tabs ......................................................378
Tip 15: Use a Pivot Table to Explode a Data Set to Different Workbooks .............................................379
What’s Next ............................................................................................................................................381

15 Dr. Jekyll and Mr. GetPivotData.................................................................................................383
  Turning Off the Evil GetPivotData Problem ....................................................................................384
  Preventing GetPivotData by Typing the Formula ........................................................................387
  GetPivotData Is Surely Evil—Turn It Off ......................................................................................387
  Why Did Microsoft Force GetPivotData on Us? ........................................................................388
Using GetPivotData to Solve Pivot Table Annoyances ........................................................................389
  Build an Ugly Pivot Table ..............................................................................................................390
  Build the Shell Report ....................................................................................................................393
  Using GetPivotData to Populate the Shell Report ........................................................................395
  Updating the Report in Future Months .........................................................................................398

Index ..................................................................................................................................................401
About the Authors

Bill Jelen, Excel MVP and the host of MrExcel.com, has been using spreadsheets since 1985, and he launched the MrExcel.com website in 1998. Bill was a regular guest on Call for Help with Leo Laporte and has produced more than 1,500 episodes of his daily video podcast, Learn Excel from MrExcel. He is the author of 38 books about Microsoft Excel and writes the monthly Excel column for Strategic Finance magazine and his Excel tips appear regularly in CFO Excel Pro newsletter and CFO Magazine. Before founding MrExcel.com, Bill Jelen spent 12 years in the trenches, working as a financial analyst for the finance, marketing, accounting, and operations departments of a $500 million public company. He lives near Akron, Ohio with his wife, Mary Ellen.

Mike Alexander is a Microsoft Certified Application Developer (MCAD) and author of several books on advanced business analysis with Microsoft Access and Excel. He has more than 15 years of experience consulting and developing Office solutions. Mike has been named a Microsoft MVP for his ongoing contributions to the Excel community. In his spare time, he runs a free tutorial site, www.datapigtechnologies.com, where he shares basic Access and Excel tips to the Office community.

Dedication

To everyone at Boca Raton Fire Department

—Bill Jelen

To my twelve fans at datapigtechnologies.com

—Mike Alexander
Acknowledgments

Mike Alexander is the funniest guy doing live Excel seminars. I appreciate him as a coauthor on all four editions of this book, which has earned the #1 spot on the Amazon Computer Book bestseller list (for 54 minutes one day in January). Rob Collie of PowerPivotPro.com keeps me up to speed on PowerPivot. At Microsoft, thanks to Scott Ruble and Diego Oppenheimer for always being willing to answer a quick question. At MrExcel.com, thanks to Tracy Syrstad, Wei Jiang, Scott Pearson, Tyler Nash, and an entire community of people passionate about Excel. Thanks to VoG, Richard Schollar, Jerry JS411, Daniel Nieves, and Cindy Kredo. Loretta Yates at Pearson Education is the best editor ever. Bob Umlas keeps us on our toes as tech editor. Finally, thanks to my wife, Mary Ellen, for her support during the writing process.

—Bill Jelen

Thanks to Bill Jelen for deciding to coauthor this book with me many editions ago. His knowledge of Excel still blows me away to this day. My deepest thanks to the professionals at Pearson Education for all the hours of work put into bringing this book to life. Thanks also to Bob Umlas, whose technical editing has helped us make numerous improvements to the examples and text in this book. Finally, a special thank-you goes to the wife and kids for putting up with all the time I spent locked away on this project.

—Mike Alexander
We Want to Hear from You!

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

We welcome your comments. You can email or write to let us know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that we cannot help you with technical problems related to the topic of this book.

When you write, please be sure to include this book’s title and author as well as your name and email address. We will carefully review your comments and share them with the author and editors who worked on the book.

Email: feedback@quepublishing.com

Mail: Que Publishing
      ATTN: Reader Feedback
      800 East 96th Street
      Indianapolis, IN 46240 USA

Reader Services

Visit our website and register this book at quepublishing.com/register for convenient access to any updates, downloads, or errata that might be available for this book.
The pivot table is the single most powerful command in all of Excel. Pivot tables came along during the 1990s when Microsoft and Lotus were locked in a bitter battle for dominance of the spreadsheet market. The race to continually add enhanced features to their respective products during the mid-1990s led to many incredible features, but none as powerful as the pivot table.

With a pivot table, you can take 1 million rows of transactional data and transform it into a summary report in seconds. If you can drag a mouse, you can create a pivot table. In addition to quickly summarizing and calculating data, pivot tables enable you to change your analysis on the fly by simply moving fields from one area of a report to another.

No other tool in Excel gives you the flexibility and analytical power of a pivot table.

What You Will Learn from This Book

It is widely agreed that close to 60 percent of Excel users leave 80 percent of Excel untouched. That is, most users do not tap into the full potential of Excel’s built-in utilities. Of these utilities, the most prolific by far is the pivot table. Despite the fact that pivot tables have been a cornerstone of Excel for almost 20 years, they remain one of the most underutilized tools in the entire Microsoft Office Suite. Having picked up this book, you are savvy enough to have heard of pivot tables or even have used them on occasion. You have a sense that pivot tables provide a power that you are not using, and you want to learn how to leverage that power to increase your productivity quickly.
Within the first two chapters, you will be able to create basic pivot tables, increase your productivity, and produce reports in minutes instead of hours. Within the first seven chapters, you will be able to output complex pivot reports with drill-down capabilities and accompanying charts. By the end of the book, you will be able to build a dynamic pivot table reporting system.

What Is New in Excel 2013’s Pivot Tables

Luckily, Microsoft continues to invest heavily in Business Intelligence (BI), and pivot tables are the front end that let you access the new features. Some of the features added to Excel 2013 pivot tables include the following:

- Excel offers thumbnails for four possible pivot tables in the Data Analysis Lens. If you happen to need one of these pivot tables, it requires three mouse clicks.
- Excel offers thumbnails for ten recommended pivot tables when you choose Insert, Recommended Pivot Tables. If you are not sure how best to summarize your data, you’ll find plenty of inspiration in this dialog.
- A new timeline slicer enables you to easily filter your pivot table by month, quarter, or year. Excel 2010 had added visual filters called *slicers*—the timeline in Excel 2013 extends slicers for date fields.
- All people using any version of Excel 2013 (except Excel RT on a tablet) can now jump through a few hoops to build a pivot table using data on multiple worksheets. This functionality replaces the need to join two worksheets using *VLOOKUP*.
- People using the client version of Office 365 or Excel Professional Plus can enable the PowerPivot add-in. PowerPivot provides drag-and-drop functionality to link tables, worksheets, SQL Server, and more. PowerPivot adds better calculated fields.
- PowerView enables you to animate your pivot tables in an ad-hoc query tool.

If you skipped Excel 2010, you missed these new features:

- New calculations for Rank, Percentage of Parent, and Running Percent of Total.
- Repeat Item Labels to fill in the blanks along the outer column fields in a pivot table.
- Slicers to create visual filters.

Skills Required to Use This Book

We have created a reference that is comprehensive enough for hard-core analysts yet relevant to casual users of Excel. The bulk of the book covers how to use pivot tables in the Excel user interface. Chapter 10, “Mashing up Data with PowerPivot,” delves into the PowerPivot window. Chapter 14, “Advanced PivotTable Tips and Techniques,” describes how to create pivot tables in Excel’s powerful VBA macro language. This means that any user who has a firm grasp of the basics, such as preparing data, copying, pasting, and entering simple formulas, should not have a problem understanding the concepts in this book.
Skills Required to Use This Book

Your manager asks you to create a one-page summary of a sales database. He would like to see total revenue by region and product. Suppose you do not know how to use pivot tables. You will have to use dozens of keystrokes or mouse clicks to complete this task.

First, you have to build the outline of the report:

1. Copy the Product column to a blank section of the worksheet.
2. Use Data, Remove Duplicates to eliminate the duplicates.
3. Delete the Product heading.
4. Copy the unique list of products and then use Paste Special Transpose to turn the list sideways.
5. Delete the vertical list of products.
6. Copy the Region column to a blank section of the worksheet.
7. Use Data, Remove Duplicates to remove the duplicates.
8. Delete the Region heading.
9. Cut and paste the products so they appear left of and below the regions.

At this point, I count 27 mouse clicks or keystrokes. You’ve built the shell of the final report, but there are no numbers inside yet, as shown in Figure I.1.

Next, you need to build the relatively new SUMIFS function to total the revenue for the intersection of a region and product. As shown in Figure I.2, a formula of $=SUMIFS(\text{GS}2:\text{GS}564, \text{SC}2:\text{SC}564, \text{LS}1, \text{SB}2:\text{SB}564, \text{SK}2)$ does the trick. It takes 52 characters plus the Enter key to finish the formula, but I managed to enter the formula in 36 clicks or keystrokes using some clever navigation tricks I’ve learned over the years.

Provided you are adept at using the fill handle, you need just two more mouse drags to copy the formula to the rest of the table.

---

**CASE STUDY: LIFE BEFORE PIVOT TABLES**

Your manager asks you to create a one-page summary of a sales database. He would like to see total revenue by region and product. Suppose you do not know how to use pivot tables. You will have to use dozens of keystrokes or mouse clicks to complete this task.

First, you have to build the outline of the report:

1. Copy the Product column to a blank section of the worksheet.
2. Use Data, Remove Duplicates to eliminate the duplicates.
3. Delete the Product heading.
4. Copy the unique list of products and then use Paste Special Transpose to turn the list sideways.
5. Delete the vertical list of products.
6. Copy the Region column to a blank section of the worksheet.
7. Use Data, Remove Duplicates to remove the duplicates.
8. Delete the Region heading.
9. Cut and paste the products so they appear left of and below the regions.

At this point, I count 27 mouse clicks or keystrokes. You’ve built the shell of the final report, but there are no numbers inside yet, as shown in Figure I.1.

![Figure I.1](image1.png)

It took 27 clicks to get to this point.

Next, you need to build the relatively new SUMIFS function to total the revenue for the intersection of a region and product. As shown in Figure I.2, a formula of $=SUMIFS(\text{GS}2:\text{GS}564, \text{SC}2:\text{SC}564, \text{LS}1, \text{SB}2:\text{SB}564, \text{SK}2)$ does the trick. It takes 52 characters plus the Enter key to finish the formula, but I managed to enter the formula in 36 clicks or keystrokes using some clever navigation tricks I’ve learned over the years.

![Figure I.2](image2.png)

If this was the year 2006, the SUMIFS function would have been an uglier SUMPRODUCT function.

Provided you are adept at using the fill handle, you need just two more mouse drags to copy the formula to the rest of the table.
Enter the heading “Total” in the total row and total column. You can do this in nine keystrokes, if you type the first heading, press Ctrl+Enter to stay in the same cell, then use Copy, select cell for second heading and Paste.

If you select K1:P6 and press Alt+Enter, you can add the total formulas in three keystrokes.

You have a nice summary report, as shown in Figure I.3. It took 77 clicks or keystrokes. If you could pull all this off in 5 or 10 minutes, you would probably be fairly proud of your Excel prowess—there were some good tricks among those 77 operations.

**Figure I.3**

A mere 77 operations later, you have a summary report.

<table>
<thead>
<tr>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Midwest</td>
<td>652861</td>
<td>644772</td>
<td>637966</td>
<td>6036</td>
<td>1741424</td>
</tr>
<tr>
<td>Northeast</td>
<td>751724</td>
<td>714009</td>
<td>620019</td>
<td>38880</td>
<td>2124612</td>
</tr>
<tr>
<td>South</td>
<td>918588</td>
<td>835551</td>
<td>644186</td>
<td>0</td>
<td>2602325</td>
</tr>
<tr>
<td>West</td>
<td>70057</td>
<td>65382</td>
<td>75349</td>
<td>28663</td>
<td>239451</td>
</tr>
<tr>
<td>Total</td>
<td>2393020</td>
<td>2163714</td>
<td>2077519</td>
<td>73559</td>
<td>6707812</td>
</tr>
</tbody>
</table>

Hand the report to your manager. Within a few minutes, your manager will come back with one of the following requests, which will certainly cause a lot of rework:

- Could you put products down the side and regions across the top?
- Could you show me the same report for only the manufacturing customers?
- Could you show profit instead of revenue?
- Could you copy this report for each of the customers?

**Invention of the Pivot Table**

When the actual pivot table was invented is in dispute. Although the Excel team coined the term *Pivot Table*, it did not appear in Excel until 1993. Pito Salas and his team at Lotus were working on the pivot table concept in 1986 and released Lotus Improv in 1991. Before then, Javelin offered functionality similar to pivot tables.

The core concept behind a pivot table is that the data, formulas, and data views are stored separately. Each column has a name, and you can group and rearrange the data by dragging field names to various positions on the report.
Invention of the Pivot Table

Say you need to produce the same report in the last case study but you want to use a pivot table. Excel 2013 offers you 10 thumbnails of recommended pivot tables to get you close to the goal. Follow these steps:

1. Click the Insert tab of the ribbon.
2. Click Recommended PivotTables. The first recommended item is Revenue by Region (see Figure I.4).
3. Click OK to accept the first pivot table.
4. Drag the Product field from the PivotTable Field List to the COLUMNS area (see Figure I.5).
5. Unselect Field Headers on the right side of the ribbon.

After just five clicks of the mouse, you have the report shown in Figure I.6.

In addition, when your manager comes back with one of the requests near the end of the prior case study, a pivot table makes it easy for you to make the changes. You find out about all of these methods in the chapters that follow, but here is a quick recap:

- Could you put products down the side and regions across the top? (10 seconds: drag Product to Rows and Region to Columns.)
- Could you show me the same report for only the Manufacturing customers? (15 seconds: select Insert Slicer, Sector, click OK, click Manufacturing.)
Could you show profit instead of revenue? (10 seconds: uncheck Revenue, check Profit.)
Could you copy this report for each of the customers? (30 seconds: move Customer to Report Filter, open the tiny drop-down next to the Options button, choose Show Report Filter Pages, click OK.)

Sample Files Used in This Book

All data files used throughout this book are available for download from www.mrexcel.com/pivotbookdata2013.html. You will find one Excel workbook per chapter and should be able to achieve the exact results shown in the figures in this book by starting with the raw data on the Data worksheet. If you simply want to work with the final pivot table, you can find it in the workbook as well.

Conventions Used in This Book

This book follows certain conventions:

- **Monospace**—Text messages you see onscreen or code appears in a monospace font.
- **Bold**—Text you type appears in a bold font.
- **Italic**—New and important terms appear in italics.
- **Initial Caps**—Tab names, dialog names, and dialog elements are presented with initial capital letters so you can identify them easily.

Referring to Versions


Referring to Ribbon Commands

Office 2007 introduced a new interface called the ribbon. The ribbon is composed of several tabs labeled Home, Insert, Page Layout, and so on. When you click the Page Layout tab, you see the icons available on the Page Layout tab.

When the active cell is inside a pivot table, two new tabs appear on the ribbon. In the help files, Microsoft calls these tabs “PivotTable Tools | Analyze” and “PivotTable Tools | Design.” For convenience, this book refers to these elements as the Analyze tab and the Design tab, respectively. The Slicer feature has a ribbon tab that Microsoft calls “Slicer Tools | Options.” This book refers to this as the Slicer tab. Excel 2013 introduced the Timeline Tools | Options tab. This book calls this the Timeline tab.
In some cases, the ribbon icon leads to a drop-down with additional choices. In these cases, the book lists the hierarchy of ribbon, icon, menu choice, and submenu choice. For example, in Figure I.7, the shorthand specifies “select Design, Report Layout, Repeat All Item Labels.”

**Figure I.7**
For shorthand, instructions might say to select Design, Report Layout, Repeat All Item Labels.

**Special Elements**

This book contains the following special elements:

---

**CASE STUDY**

Cast studies provide a real-world look at topics previously introduced in the chapter.

**NOTE**

Notes provide additional information outside the main thread of the chapter discussion that might be useful for you to know.

**TIP**

Tips provide quick workarounds and time-saving techniques to help you do your work more efficiently.

**CAUTION**

Cautions warn you about potential pitfalls you might encounter. Pay attention to Cautions because they alert you to problems that otherwise could cause you hours of frustration.
This page intentionally left blank
Customizing a Pivot Table

Although pivot tables provide an extremely fast way to summarize data, sometimes the pivot table defaults are not exactly what you need. In this case, you can use many powerful settings to tweak the information in your pivot table. These tweaks range from making cosmetic changes to changing the underlying calculation used in the pivot table.

In Excel 2013, you find controls to customize the pivot table in myriad places: the Analyze tab, Design tab, Field Settings dialog, Data Field Settings dialog, PivotTable Options dialog, and context menus. Rather than cover each set of controls sequentially, this chapter seeks to cover the following functional areas in making pivot table customization:

- **Minor cosmetic changes**—Change blanks to zeros, adjust the number format, and rename a field. The fact that you must correct these defaults in every pivot table that you create is annoying.
- **Layout changes**—Compare three possible layouts, show/hide subtotals and totals, and repeat row labels.
- **Major cosmetic changes**—Use table styles to format your table quickly.
- **Summary calculations**—Change from Sum to Count, Min, Max, and more. If you have a table that defaults to Count of Revenue instead of Sum of Revenue, you need to visit the section on this topic.
- **Advanced calculations**—Use settings to show data as a running total, percent of total, rank, percent of parent item, and more.
- **Other options**—Review more obscure options found throughout the Excel interface.
Making Common Cosmetic Changes

You need to make a few changes to almost every pivot table to make it easier to understand and interpret. Figure 3.1 shows a typical pivot table. To create this pivot table, open the Chapter 3 data file. Select Insert, Pivot Table, OK. Check the Sector and Revenue fields, and drag the Region field to the COLUMNS area.

![A typical pivot table before customization.](image)

This default pivot table contains several annoying items that you might want to change quickly:

- The default table style uses no gridlines, which makes it difficult to follow the rows and columns across.
- Numbers in the VALUES area are in a general number format. There are no commas, currency symbols, and so on.
- For sparse data sets, many blanks appear in the VALUES area. The blank cell in B5 indicates that there were no Communications sales in the Midwest. Most people prefer to see zeros instead of blanks.
- Excel renames fields in the VALUES area with the unimaginative name Sum of Revenue. You can change this name.

You can correct each of these annoyances with just a few mouse clicks. The following sections address each issue.

**Applying a Table Style to Restore Gridlines**

The default pivot table layout contains no gridlines and is rather plain. Fortunately, you can apply a table style. Any table style that you choose is better than the default.
Follow these steps to apply a table style:

1. Make sure that the active cell is in the pivot table.
2. From the ribbon, select the Design tab.
3. Three arrows appear at the right side of the PivotTable Style gallery. Click the bottom arrow to open the complete gallery, which is shown in Figure 3.2.
4. Choose any style other than the first style from the drop-down. Styles toward the bottom of the gallery tend to have more formatting.
5. Select the check box for Banded Rows to the left of the PivotTable Styles gallery. This draws gridlines in light styles and adds row stripes in dark styles.

It does not matter which style you choose from the gallery; any of the 84 other styles are better than the default style.

➔ For more details about customizing styles, see “Customizing the Pivot Table Appearance with Styles and Themes,” p. 59.

Changing the Number Format to Add Thousands Separators

If you have gone to the trouble of formatting your underlying data, you might expect that the pivot table would capture some of this formatting. Unfortunately, it does not. Even if your underlying data fields were formatted with a certain numeric format, the default pivot
The table presents values formatted with a general format. As a sign of some progress, when you create pivot tables from PowerPivot, you can specify the number format for a field before creating the pivot table. This functionality has not come to regular pivot tables, yet. For more about PowerPivot, read Chapter 10, “Mashing Up Data with PowerPivot.”

For example, in the figures in this chapter, the numbers are in the thousands or tens of thousands. At this level of sales, you would normally have a thousands separator and probably no decimal places. Although the original data had a numeric format applied, the pivot table routinely formats your numbers in an ugly general style.

You will be tempted to format the numbers using the right-click menu and choosing Number Format. This is not the best way to go. You will be tempted to format the cells using the tools on the Home tab. This is not the way to go. Either of these methods temporarily fixes the problem, but you lose the formatting as soon as you move a field in the pivot table. The right way to solve the problem is to use the Number Format button in the Value Field Settings dialog.

You have three ways to get to this dialog:

- Right-click a number in the VALUES area of the pivot table and select Value Field Settings.
- Click the drop-down on the Sum of Revenue field in the drop zones of the PivotTable Field List and then select Value Field Settings from the context menu.
- Select any cell in the VALUES area of the pivot table. From the Analyze tab, select Field Settings from the Active Field group.

As shown in Figure 3.3, the Value Field Settings dialog is displayed. To change the numeric format, click the Number Format button in the lower-left corner.

![Figure 3.3](display_the_value_field_settings_dialog_and_then_click_number_format)

In the Format Cells dialog, you can choose any built-in number format or choose a custom format. For example, choose Currency, as shown in Figure 3.4.
Replacing Blanks with Zeros

One of the elements of good spreadsheet design is that you should never leave blank cells in a numeric section of the worksheet. Even Microsoft believes in this rule; if your source data for a pivot table contains one million numeric cells and one blank cell, Excel 2013 treats the entire column as if it is text and chooses to Count the column instead of Sum. This is why it is incredibly annoying that the default setting for a pivot table leaves many blanks in the VALUES area of some pivot tables.

The blank tells you that there were no sales for that particular combination of labels. In the default view, an actual zero is used to indicate that there was activity, but the total sales were zero. This value might mean that a customer bought something and then returned it, resulting in net sales of zero. Although there are limited applications in which you need to differentiate between having no sales and having net zero sales, this seems rare. In 99% of the cases, you should fill in the blank cells with zeros.

Follow these steps to change this setting for the current pivot table:

1. Right-click any cell in the pivot table and choose PivotTable Options.
2. On the Layout & Format tab in the Format section, type 0 next to the field labeled For Empty Cells Show (see Figure 3.5).
3. Click OK to accept the change.

The result is that the pivot table is filled with zeros instead of blanks, as shown in Figure 3.6.
Figure 3.5
Enter a zero in the For Empty Cells Show box to replace the blank cells with zero.

Figure 3.6
Your report is now a solid contiguous block of non-blank cells.

Changing a Field Name

Every field in the final pivot table has a name. Fields in the row, column, and filter areas inherit their names from the heading in the source data. Fields in the data section are given names such as Sum of Revenue. In some instances, you might prefer to print a different name in the pivot table. You might prefer Total Revenue instead of the default name. In these situations, the capability to change your field names comes in quite handy.

Although many of the names are inherited from headings in the original data set, when your data is from an external data source, you might not have control over field names. In these cases, you might want to change the names of the fields as well.
To change a field name in the VALUES area, follow these steps:

1. Select a cell in the pivot table that contains the appropriate type of value. You might have a pivot table with both Sum of Quantity and Sum of Revenue in the VALUES area. Choose a cell that contains a Sum of Revenue value.

2. Go to the Analyze tab in the ribbon. A Pivot Field Name text box appears below the heading of Active Field. The box currently contains Sum of Revenue.

3. Type a new name in the box, as shown in Figure 3.7. Click a cell in your pivot table to complete the entry and have the heading in A3 change. The name of the field title in the VALUES drop zone also changes to reflect the new name.

One common frustration occurs when you would like to rename Sum of Revenue to Revenue. The problem is that this name is not allowed because it is not unique; you already have a Revenue field in the source data. To work around this limitation, you can name the field and add a space to the end of the name. Excel considers “Revenue” (with a space) to be different from “Revenue” (with no space). Because this change is cosmetic, the readers of your spreadsheet do not notice the space after the name.

![Figure 3.7](image)

The name typed in the Custom Name box appears in the pivot table. Although names should be unique, you can trick Excel into accepting a similar name by adding a space to the end of it.

**Making Report Layout Changes**

Excel 2013 offers three report layout styles. The Excel team continues to offer the newer Compact Layout as the default report layout, even though I continually hound them about the fact that people who work in the real world would rather use the Tabular Report Layout, or at least would like to have a choice about which one to use as a default.

If you consider three report layouts, and the ability to show subtotals at the top or bottom, plus choices for blank rows and Repeat All Item Labels, you have 16 different layout possibilities available.

Layout changes are controlled in the Layout group of the Design tab, as shown in Figure 3.8. This group offers four icons:

- **Subtotals**—Moves subtotals to the top or bottom of each group or turns them off.
- **Grand Totals**—Turns the grand totals on or off for rows and columns.
**Report Layout**—Uses the Compact, Outline, or Tabular forms. Offers an option to repeat item labels.

**Blank Rows**—Inserts or removes blank lines after each group.

---

**Figure 3.8**
The Layout group on the Design tab offers different layouts and options for totals.

---

**Using the New Compact Layout**

By default, all new pivot tables use the Compact layout shown in Figure 3.6. In this layout, multiple fields in the row area are stacked in column A. Note in the figure that the Communications sector and the AT&T customer are both in column A.

The Compact form is suited for using the Expand and Collapse icons. Select one of the Sector value cells such as Communications in A5. Click the Collapse Field icon on the Analyze tab. Excel hides all the customer details and shows only the sectors, as shown in Figure 3.9.

After a field is collapsed, you can show detail for individual items by using the plus icons in column A, or you can click Expand Field on the Analyze tab to see the detail again.

---

**TIP**

If you select a cell in the innermost row field and click Expand Field on the Options tab, Excel displays the Show Detail dialog, as shown in Figure 3.10, to enable you to add a new innermost row field.
Making Report Layout Changes

3

Using the Outline Form Layout

When you select Design, Layout, Report Layout, Show in Outline Form, Excel puts each row field in a separate column. The pivot table shown in Figure 3.11 is one column wider, with revenue values starting in C instead of B. This is a small price to pay for allowing each field to occupy its own column. Soon, you will find out how to convert a pivot table to values so you can further sort or filter. When you do this, you will want each field in its own column.

The Excel team added the Repeat All Item Labels option to the Report Layout tab starting in Excel 2010. This alleviated a lot of busy work because it becomes two clicks to fill in all the blank cells along the outer row fields. Choosing to repeat the item labels causes values to appear in cells A6:A7, A9:A10, and A12:A15 of Figure 3.11.

Figure 3.11 shows the pivot table in Outline form with labels repeated.

This layout is better suited if you plan to copy the values from the pivot table to a new location for further analysis. Although the Compact layout offers a clever approach by squeezing multiple fields in one column, it is not ideal for reusing the data later.
Chapter 3           Customizing a Pivot Table

Figure 3.11
The Outline layout puts each row field in a separate column.

By default, both the Compact and Outline layouts put the subtotals at the top of each group. You can use the Subtotals drop-down on the Design tab to move the totals to the bottom of each group, as shown in Figure 3.12. In Outline view, this causes a not-really-useful heading row to appear at the top of each group. Cell A5 contains “Communications” without any additional data in the columns to the right. Consequently, the pivot table occupies 44 rows instead of 37 rows because each of the seven sector categories has an extra header.

Figure 3.12
With subtotals at the bottom of each group, the pivot table occupies several more rows.

Using the Traditional Tabular Layout

Pivot table veterans will recognize the Tabular layout shown in Figure 3.13. This layout is similar to the one that has been used in pivot tables since their invention through Excel 2003. In this layout, the subtotals can never appear at the top of the group. The new Repeat All Item Labels works with this layout, as shown in Figure 3.13.
The Tabular layout is the best layout if you expect to use the resulting summary data in a subsequent analysis. If you wanted to reuse the table in Figure 3.13, you would do additional “flattening” of the pivot table by choosing Subtotals, Do Not Show Subtotals, and Grand Totals, Off for Rows and Columns.

Finally, you want to convert from a live pivot table to static values. To make these changes, follow these steps:

1. Select any cell in the pivot table.
2. From the Design tab, select Grand Totals, Off for Rows and Columns.
4. Drag the Region tile from the COLUMNS area in the PivotTable Field List. Drop this field between Sector and Customer in the ROWS area.
5. Check Profit and Cost in the top of the PivotTable Field List. Because both fields are numeric, they move to the VALUES area and appear in the pivot table as new columns. The report is now a contiguous solid block of data, as shown in Figure 3.14.
6. Select one cell in the pivot table. Press Ctrl+* to select all the data in the pivot table.
7. Press Ctrl+C to copy the data from the pivot table.
8. Select a blank section of a worksheet.
9. Right-click and choose Paste Values to open the fly-out menu. Select Paste Values and Number Formatting, as shown in Figure 3.15. Excel pastes a static copy of the report to the worksheet.
10. If you no longer need the original pivot table, select the entire pivot table and press the Delete key to clear the cells from the pivot table and free up the area of memory that was holding the pivot table cache.

CASE STUDY: CONVERTING A PIVOT TABLE TO VALUES

Say that you want to convert the pivot table shown in Figure 3.13 to be a regular data set that you can sort, filter, chart, or export to another system. You don’t need the Sectors totals in rows 7, 10, 15, and so on. You don’t need the Grand Total at the bottom. And, depending on your future needs, you might want to move the Region field from the Columns area to the Rows area. This would allow you to add Cost and Profit as new columns in the final report.

![Figure 3.13](image-url)
The result is a solid block of summary data. These 27 rows are a summary of the 500+ rows in the original data set, but they also are suitable for exporting to other systems.

**Controlling Blank Lines, Grand Totals, and Other Settings**

Additional settings on the Design tab enable you to toggle various elements.

The Blank Rows drop-down offers a choice for Insert Blank Row After Each Item. This setting only applies to pivot tables with two or more row fields. Blank rows are not added after each item in the inner row field. You see a blank row after each group of items in the outer row fields. As shown in Figure 3.16, the blank row after each Region makes the report easier to read. However, if you remove Sector from the report, you would have only Region in the row fields and no blank rows would appear (see Figure 3.17).
Making Report Layout Changes

Figure 3.16
The Blank Rows setting makes the report easier to read.

Figure 3.17
However, blank rows will not appear when there is only one item in the row field.

For those of you following along with the sample files, there was quite a leap from the pivot table in Figure 3.14 to Figure 3.16, but it is still the same pivot table. Here is how to make the changes:

1. Uncheck Sector, Customer, Profit and Cost in the Pivot Table Fields task pane.
2. Drag the Product field to the Columns area.
3. Recheck the Sector field to move it to the second Row field.
4. Make sure the active cell is in column A.
5. On the Design tab of the ribbon, open Subtotals and choose Show All Subtotals at the Bottom of the Group.
6. Finally, as shown in Figure 3.16, open the Blank Rows drop-down and choose to add blank rows. To get to Figure 3.17, uncheck the Sector field.
Grand totals can appear at the bottom of each column and/or at the end of each row, or they can be turned off altogether. Settings for grand totals appear in the Grand Totals drop-down of the Layout group on the Design tab. The wording in this drop-down is a bit confusing, so Figure 3.18 shows what each option provides. The default is to show grand totals for rows and columns, as in Figure 3.17.

If you want a grand total column but no grand total at the bottom, choose On for Rows Only, as shown at the top of Figure 3.18. To me, this seems backward. To keep the grand total column, you have to choose to turn on grand totals for rows only. I guess the rationale is that each cell in F5:F8 is a grand total of the row to the left of the cell. Hence, you are showing the grand totals for each row, but not for the columns. Perhaps someday Microsoft will ship a version of Excel in English-Midwest where this setting would be called “Keep the Grand Total Column.” But for now, it remains confusing.

In a similar fashion, to show a grand total row but no grand total column, you open the Grand Totals menu and choose On for Columns Only. Again, in some twisted version of the English language, cell B18 is totaling the cells in the column above it.

The final choice, Off for Rows and Columns, is simple enough. Excel shows neither a grand total column nor a grand total row.

Back in Excel 2003, pivot tables were shown in Tabular layout and logical headings such as “Region” and “Product” would appear in the pivot table, as shown in the top pivot table in Figure 3.19. When the Excel team switched to Compact form, they replaced those headings with “Row Labels” and “Column Labels.” These add nothing to the report. To toggle off those headings, look on the far right side of the Analyze tab for an icon called Field.
Customizing the Pivot Table Appearance with Styles and Themes

You can quickly apply color and formatting to a pivot table report using the 85 built-in styles in the PivotTable Styles gallery on the Design tab. These 85 styles are further modified by the four checkboxes to the left of the gallery. Combined with the 48 themes on the Page Layout tab, you have 65,280 easy ways to format a pivot table. If none of those provide what you need, you can define a new style.

Start with the four check boxes in the PivotTable Style Options group of the Design tab of the ribbon. You can choose to apply special formatting to the row headers, column headers, banded rows, or banded columns. My favorite choice here is banded rows, because it makes...
it easier for the reader’s eye to follow a row across a wide report. You should choose from these settings first because the choices here will modify the thumbnails shown in the Styles gallery.

The PivotTable Styles gallery on the Design tab offers 85 built-in styles. Grouped into 28 styles each of Light, Medium, and Dark, the gallery offers variations on the accent colors used in the current theme. In Figure 3.20, you can see which styles in the gallery truly support banded rows and which just offer a bottom border between rows.

Note that you can modify the thumbnails for the 85 styles shown in the gallery by using the four check boxes in the PivotTable Style Options group.

Figure 3.20
The styles are shown here with accents for row headers, column headers, and alternating colors in the columns.

The Live Preview feature in Excel 2013 works in the Styles gallery. As you hover your mouse cursor over style thumbnails, the worksheet shows a preview of the style.

**Customizing a Style**

You can create your own pivot table styles. The new styles are added to the gallery for the current workbook only. To use the custom style in another workbook, copy and temporarily paste the formatted pivot table to the other workbook. After the pivot table has been pasted, apply the custom style to an existing pivot table in your workbook and then delete the temporary pivot table.

Say that you want to create a pivot table style in which the banded colors are three rows high. Follow these steps to create the new style:

1. Find an existing style in the PivotTable Styles gallery that supports banded rows. Right-click the style in the gallery and select Duplicate. Excel displays the Modify PivotTable Quick Style dialog.
2. Choose a new name for the style. Excel initially appends a “2” to the existing style name, which means you have a name such as PivotStyleDark3 2. Type a better name, such as Greenbar.

3. In the Table Element list, click First Row Stripe. A new section called Stripe Size appears in the dialog.

4. Select 3 from the Stripe Size drop-down, as shown in Figure 3.21.

![Figure 3.21](image)

5. To change the stripe color, click the Format button. The Format Cells dialog appears. Click the Fill tab and then choose a fill color. If you want to be truly authentic, choose More Colors, Custom, and use Red=200, Green=225, Blue=204 to simulate 1980s-era greenbar paper. Click OK to accept the color and return to the Modify PivotTable Quick Style dialog.

6. In the Table Element List, click Second Row Stripe. Change the Stripe Size drop-down to be 3. Modify the format to use a lighter color such as white.

7. If you plan on creating more pivot tables in this workbook, choose the Set As Default PivotTable Style for This Document check box in the lower left.

8. Optionally edit the colors for Header Row and Grand Total Row.

9. Click OK to finish building the style. It is strange that the Excel team doesn’t automatically apply this new style to the pivot table. After a few minutes of work to tweak the style, the pivot table does not change.

10. Your new style should be the first thumbnail visible in the styles gallery. Click that style to apply it to the pivot table. (Provided you have not added more than seven custom...
styles, the thumbnail should be visible in the closed gallery—you can choose it without reopening the gallery.)

Modifying Styles with Document Themes

The formatting options for pivot tables in Excel 2013 are impressive. The 84 styles, combined with 16 combinations of the Style options, make for hundreds of possible format combinations.

In case you become tired of these combinations, you can visit the Themes drop-down on the Page Layout tab, where 48 built-in themes are available. Each theme has a new combination of accent colors, fonts, and shape effects.

To change a document theme, open the Themes drop-down on the Page Layout tab. Choose a new theme, and the colors used in the pivot table change to match the theme.

**CAUTION**

Changing the theme affects the entire workbook. It changes the colors and fonts, and affects all charts, shapes, tables, and pivot tables on all worksheets of the active workbook.

**TIP**

Some of the themes use unusual fonts. You can apply the colors from a theme without changing the fonts in your document by using the Colors drop-down next to the Themes menu, as shown in Figure 3.22.
Changing Summary Calculations

When creating your pivot table report, by default Excel summarizes your data by either counting or summing the items. Instead of Sum or Count, you might want to choose functions such as Min, Max, and Count Numeric. In all, 11 options are available. However, the common reason to change a summary calculation is that Excel incorrectly chose to count instead of sum your data.

Understanding Why One Blank Cell Causes a Count

If all the cells in a column contain numeric data, Excel chooses to sum. If just one cell is either blank or contains text, Excel chooses to count.

In Figure 3.23, the worksheet contains mostly numeric entries but has a single blank cell in G2. The one blank cell is enough to cause Excel to count the data instead of summing.

<table>
<thead>
<tr>
<th>Sector</th>
<th>Region</th>
<th>Product</th>
<th>Date</th>
<th>Customer</th>
<th>Quantity</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Midwestern</td>
<td>Gizmo</td>
<td>1/1/2014</td>
<td>Ford</td>
<td>1006</td>
<td>10320</td>
<td>12380</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Northeast</td>
<td>Gadget</td>
<td>1/2/2014</td>
<td>Verizon</td>
<td>100</td>
<td>2257</td>
<td>984</td>
<td>1273</td>
</tr>
</tbody>
</table>

In Excel 2013, the first clue that you have a problem appears when you select the check box for Revenue in the Fields section of the PivotTable Field List. If Excel moves the Revenue field to the Rows drop zone, you know that Excel considers the field to be text instead of numeric.

Be vigilant while dragging fields into the Values drop zone. If a calculation appears to be dramatically low, check to see if the field name reads Count of Revenue instead of Sum of Revenue. When you create the pivot table in Figure 3.24, you should notice that your company has only $562 in revenue instead of millions. This should be a hint that the heading in B3 reads Count of Revenue instead of Sum of Revenue. In fact, 562 is one less than the number of records in the data set—Excel doesn’t include the blank cell in the Count function.

Figure 3.24
Your revenue numbers look anemic. Notice in cell B3 that Excel chose to count instead of sum the revenue. This often happens if you inadvertently have one blank cell in your Revenue column.
To override the incorrect Count calculation, right-click any pivot table cell in the Revenue column. Choose Summarize Values By and then choose Sum (see Figure 3.25).

![Figure 3.25](image)

Change the function from Count to Sum in the Summarize Values By drop-down.

### Using Functions Other Than Count or Sum

The settings for Summarize Values By and Show Values As were temporarily promoted to drop-downs in the Excel 2010 ribbon, but they are no longer in the ribbon in Excel 2013. All of the pivot table calculations icons for the Quick Access Toolbar were removed from Excel 2013. They were apparently removed to make space for Insert Timeline, Drill Down, Drill Up, and Recommended Pivot Tables. If you were a fan of Summarize Values By and Show Values As, you can continue to use them from the right-click menu or by selecting a cell and pressing Shift+F10.

The options have always been available in the Value Field Settings dialog.

Excel offers six functions through the Summarize Values By command, plus five more options when you select More Options. The options available are as follows:

- **Sum**—Provides a total of all numeric data.
- **Count**—Counts all cells, including numeric, text, and error cells. This is equivalent to the Excel function `=COUNTA()`.
- **Average**—Provides an average.
- **Max**—Shows the largest value.
- **Min**—Shows the smallest value.
- **Product**—Multiplies all the cells together. For example, if your data set has cells with values of 3, 4, and 5, the product would be 60.
- **Count Nums**—Counts only the numeric cells. This is equivalent to the Excel function `=COUNT()`.
**StdDev and StdDevP**—Calculate the standard deviation. Use StdDevP if your data set contains the complete population. Use StdDev if your data set contains a sample of the population.

**Var and VarP**—Calculate the statistical variance. Use VarP if your data contains a complete population. If your data contains only a sampling of the complete population, use Var to estimate the variance.

---

**NOTE**

Standard deviations explain how tightly results are grouped around the mean.

---

**Adding and Removing Subtotals**

Subtotals are an essential feature of pivot table reporting. Sometimes you might want to suppress the display of subtotals, and other times you might want to show more than one subtotal per field.

**Suppress Subtotals When You Have Many Row Fields**

When you have many row fields in your report, subtotals can mire your view. For example, in Figure 3.26, there is no need to show subtotals for each market because there is only one sales rep for each market.

![Figure 3.26](image)

Sometimes you do not need subtotals at every level.

If you used the Subtotals drop-down on the Design tab, you would turn off all subtotals, including the Region subtotals and the Market subtotals. The Region subtotals are still providing good information, so you want to use the Subtotals setting in the Field Settings dialog. Choose one cell in the Market column. On the Analyze tab, choose Field Settings. Change the Subtotals setting from Automatic to None (see Figure 3.27).
To remove subtotals for the Market field, click the Market field in the drop zone section of the PivotTable Field List. Select Field Settings. In the Field Settings dialog, select None under Subtotals, as shown in Figure 3.27.

### Adding Multiple Subtotals for One Field

You can add customized subtotals to a row or column label field. Select the Region field in the bottom of the PivotTable Field List and select Field Settings.

In the Field Settings dialog for the Region field, select Custom and then select the types of subtotals you would like to see. The dialog in Figure 3.28 shows five custom subtotals selected for the Region field. It is rare to see pivot tables use this setting. It is not perfect. Note that the Count of 211 records automatically gets a currency format like the rest of the column, even though this is not a dollar figure. Also, the Average of $12,333 for South is an average of the detail records, not an average of the individual Market totals.

> **TIP**
>
> If you need to calculate the average of the four regions, you can do it with the DAX formula language and PowerPivot. See Chapter 10.

---

**Figure 3.27**

Use the Subtotals setting in the field list to turn off subtotals for one field.
Changing the Calculation in a Value Field

The Value Field Settings dialog offers 11 options on the Summarize Values As tab and 15 main options on the Show Values As tab. Whereas the options under the first tab are the basic Sum, Average, Count, Max, and Min options that are ubiquitous throughout Excel, the 15 options under Show Values As offer interesting options such as % of Total, Running Total, and Ranks.

For Excel 2010 only, these options appeared as two drop-down menus in the ribbon. They were removed from the 2013 ribbon, but they still exist in the right-click menu. Because many of the calculations require one or two additional settings, you end up back in an extra dialog anyway. If you get in the habit of using the Value Field Settings dialog, you will have access to all the settings in one dialog.

Six of the Show Values As calculations were introduced in Excel 2010. These include % of Parent Item, Rank, and % Running Total In.

The following examples show how to use the various calculation options. To contrast the various settings, you can build a pivot table where you drag the Revenue field to the VALUES area nine separate times. Each shows up as a new column in the pivot table. Over the course of the rest of the chapter, you see the settings required for the calculations in each column.

To change the calculation for a field, select one value cell for the field and click the Field Settings button on the Analyze tab of the ribbon. The Value Field Settings dialog is similar to the Field Settings dialog, but it has two tabs. The first tab, Summarize Values By, contains Sum, Count, Average, Max, Min, Product, Count Numbers, StdDev, StdDevP, Var, and VarP. Choosing one of these 11 calculation options changes the data in the column. In Figure 3.29, columns B through D show various settings from the Summarize Values By tab.
Column B is the default Sum calculation. It shows the total of all records for a given market. Column C shows the Average order for each item by Market. Column D shows a count of the records. You can change the heading to say “# of Orders” or “# of Records” or whatever is appropriate. Note that the count is the actual count of records, not the count of distinct items. Counting distinct items has been difficult in pivot tables, but now is possible using PowerPivot. See Chapter 10 for more details.

Far more interesting options appear on the Show Values As tab of the Value Field Settings dialog, as shown in Figure 3.30. Fifteen options appear in the drop-down. Depending on the option you choose, you might need to specify either a Base Field or a Base Field and a Base Item. Columns E through J in Figure 3.29 show some of the calculations possible using Show Values As.

Table 3.1 summarizes the Show Values As options.
### Calculations in Show Value As

<table>
<thead>
<tr>
<th>Show Value As</th>
<th>Additional Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Calculation</td>
<td>None</td>
<td>Shows percentages so all the detail cells in the pivot table total 100%.</td>
</tr>
<tr>
<td>% of Grand Total</td>
<td>None</td>
<td>Shows percentages that total up and down the pivot table to 100%.</td>
</tr>
<tr>
<td>% of Row Total</td>
<td>None</td>
<td>Shows percentages that total across the pivot table to 100%.</td>
</tr>
<tr>
<td>% of Parent Row Total</td>
<td>None</td>
<td>With multiple row fields, shows a row’s percentage of the parent item’s total.</td>
</tr>
<tr>
<td>% of Parent Column Total</td>
<td>None</td>
<td>With multiple column fields, shows a column’s percentage of the parent column’s total.</td>
</tr>
<tr>
<td>Index</td>
<td>None</td>
<td>Calculates the relative importance of items.</td>
</tr>
<tr>
<td>% of Parent Total</td>
<td>Base Field only</td>
<td>With multiple row and/or column fields, calculates a cell’s percent of the parent item’s total.</td>
</tr>
<tr>
<td>Running Total In</td>
<td>Base Field only</td>
<td>Calculates a running total.</td>
</tr>
<tr>
<td>% Running Total In</td>
<td>Base Field only</td>
<td>Calculates a running total as a percentage of the total.</td>
</tr>
<tr>
<td>Rank Smallest to Largest</td>
<td>Base Field only</td>
<td>Provides a numeric rank, with 1 as the smallest item.</td>
</tr>
<tr>
<td>Rank Largest to Smallest</td>
<td>Base Field only</td>
<td>Provides a numeric rank, with 1 as the largest item.</td>
</tr>
<tr>
<td>% of</td>
<td>Base Field and Base Item</td>
<td>Expresses the values for one item as a percentage of another item.</td>
</tr>
<tr>
<td>Difference From</td>
<td>Base Field and Base Item</td>
<td>Shows the difference of one item compared to another item or to the previous item.</td>
</tr>
<tr>
<td>% Difference From</td>
<td>Base Field and Base Item</td>
<td>Shows the percent difference of one item compared to another item or to the previous item.</td>
</tr>
</tbody>
</table>

The capability to create custom calculations is another example of the unique flexibility of pivot table reports. With the Show Data As setting, you can change the calculation for a particular data field to be based on other cells in the VALUES area.

The following sections illustrate a number of Show Values As options.
Showing Percentage of Total

Column E of Figure 3.29 shows the % of Total. New York with $2.1 million in revenue represents 31.67% of the $6.7 million total revenue. Column E uses % of Column Total on the Show Values As tab. Two other similar options are % of Row Total and % of Grand Total. Choose one of these based on whether your text fields are going down the report, across the report, or both down and across.

Using % Of to Compare One Line to Another Line

The % Of option enables you to compare one item to another item. For example, the current data set shows that New York is the largest market. Perhaps this company started in New York and has the largest concentration of customers in New York. Perhaps the home office is in New York. The people in New York might have a New York-centric view of the world and want to show how all of the other markets are doing as a percentage of New York. Cell E6 of Figure 3.31 shows that Atlanta is about 25% the size of New York in sales.

To set up this calculation, choose Show Values As, % Of. For the Base Field, choose Market because this is the only field in the ROWS area. For the Base Item, choose New York. The result is shown in Figure 3.31.

Showing Rank

Two ranking options were added in Excel 2010. Column G of Figure 3.32 shows Rank Largest to Smallest. New York is ranked #1, Minneapolis is #12. A similar option is Rank Smallest to Largest, which would be good for the pro golf tour.

To set up a rank, choose Value Field Settings, Show Values As, Rank Largest to Smallest. You are required to choose a Base Field. In this example, because Market is the only row field, it is the Base Field.
These rank options in Excel 2013 show that pivot tables have a strange way of dealing with ties. I say *strange* because they do not match any of the methods already established by the Excel functions =RANK(), =RANK.AVG(), and =RANK.EQ(). For example, if the top two markets have a tie, they are both assigned a rank of 1, and the third market is assigned a rank of 2.

### Tracking Running Total and Percent of Running Total

Running total calculations is common in reports where you have months running down the column or when you want to show that the top $N$ customers make up $N\%$ of the revenue. The Running Total In calculation has been in Excel for many versions. The $\%$ Running Total In setting was added in Excel 2010.

In Figure 3.33, cell I8 shows that the top four markets account for 76.97\% of the total sales.
To specify Running Total In (as shown in Column H) or % Running Total In (Column J), select Field Settings, Show Values As, Running Total In. You have to specify a Base Field, which in this case is the row field: Market.

**Display Change from a Previous Field**

Figure 3.34 shows the % Difference From setting. This calculation requires a base field and base item. You could show how each market compares to New York by specifying New York as the base item. This would be similar to Figure 3.31, except each market would be shown as a percentage of New York.

![Figure 3.34](image)

The % Difference From options enable you to compare each row to the previous or next row.

When you have date fields, it would make sense to use % Difference From and choose (previous) as the base item. Note the first cell will not have a calculation because there is no previous data in the pivot table.

**Tracking Percent of Parent Item**

The legacy % of Total settings always divide the current item by the grand total. In Figure 3.35, cell E4 says that Chicago is 2.75% of the total data set. A common question at the MrExcel.com message board is how to calculate Chicago’s revenue as a percentage of the Midwest region total. This was possible but difficult before Excel 2010. Starting in Excel 2010, Excel added the % of Parent Row, % of Parent Column, and % of Parent Total.

To set up this calculation in Excel 2013, use Field Settings,Show Values As, % of Parent Row Total. Cell D4 in Figure 3.35 shows that Chicago’s $184K is 10.59% of the Midwest Total of $1,741K.

Although it makes sense, the calculation on the subtotal rows might seem confusing. D4:D8 shows the percentage of each market as compared to the Midwest total. The values in D9, D11, D16, and D19 are comparing the region total to the grand total. For example, the 31.67% in D11 is saying that the Northeast region’s $2.1 million is a little less than a third of the $6.7 million grand total.
Track Relative Importance with the Index Option

The final option, Index, creates a somewhat obscure calculation. Microsoft claims that this calculation describes the relative importance of a cell within a column. In Figure 3.36, Georgia peaches have an index of 2.55 and California peaches have an index of 0.50. If the peach crop is wiped out next year, it will be more devastating to Georgia fruit production than to California fruit production.

Here is the exact calculation: First, divide Georgia peaches by Georgia total. This is 180/210, or 0.86. Next, divide total peach production (285) by total fruit production (847). This shows that peaches have an importance ratio of 0.34. Now, divide the first ratio by the second ratio: 0.86 / 0.34.

In Ohio, apples have an index of 4.91, so an apple blight would be bad for the Ohio fruit industry.

However, even after writing about this calculation for 10 years, there are parts that I don’t quite comprehend. What if a state like Hawaii relied on productions of lychees but lychees were nearly immaterial to U.S. fruit production? If lychees were half of Hawaii fruit production, but 0.001 of U.S. fruit production, the Index calculation would skyrocket to 500.
Next Steps

Note that the following pivot table customizations are covered in subsequent chapters:

- Sorting a pivot table is covered in Chapter 4.
- Filtering records in a pivot table is covered in Chapter 4.
- Grouping daily dates up to months or years is covered in Chapter 4.
- Adding new calculated fields is covered in Chapter 5, “Performing Calculations Within Your Pivot Tables.”
- Using data visualizations and conditional formatting in a pivot table is covered in Chapter 4.

Using these tools is a great way to focus your pivot table on the largest drivers of success for your business.
This page intentionally left blank
Symbols

- (equal sign), 364
% Of, 70
% of Parent calculation, 334
% of Parent Item, tracking, 72
% of Running Total, tracking Running Total and % of Running Total, 71-72
% of Total calculation, 334

A

ActiveX controls, 284
AddFields method, 340
adding
   calculated columns using DAX, PowerPivot add-in, 234-235
calculated fields, to data sources (manually), 114-115
calculations to OLAP pivot tables, 204
calculated measures, 204-208
calculated members, 208-210
data to PowerPivot, 247-248
drill-down to charts, Power View, 267-268
Excel data by cutting and pasting, PowerPivot add-in, 233
Excel data by linking, 233-234
fields
to data area, VBA (Visual Basic for Applications), 304-305
to reports, 25-27
to Values area (DAX calculated fields), 244-246
to Filters area, 103
layers to pivot tables, 27
model fields, Data Model (Excel 2013), 353-354
new tables to Data Model, 170-171
numeric files to Values area, Data Model (Excel 2013), 354-355
rank number fields, 365-366
scrollbars, 287
subtotals, 65-67
to get page breaks, 322-323
for one field, 66-67
tables
to Data Model, 220-222
to Data Model (Excel 2013), 352-353
alignment, Power View, 265
altering recorded macros, 286-290
alternatives to pivot charts, 145
deleting underlying pivot tables, 146
distributing pictures of pivot charts, 146
hard values, 145
using cells linked back to pivot tables as source data, 147-148
Analysis Services Tutorial cube, 194
analyzing activity by market, 38
animating
pivot table data on maps, 277-280
scatter charts over time, 276
appearance of pivot tables, 59-62
customizing styles, 60-62
modifying styles with document themes, 62
Areas section drop-downs, PivotTable Fields list, 86-87
AutoFilter, 94, 370
automatically
expanding data ranges, creating, 367-368
refreshing pivot tables, 359-360
AutoShow, executive overviews, 336-338
AutoSort, 318
Average, 64, 327
avoiding repeating groups as columns, 19

B
.BaseField, 333
.BaseItem, 333
benefits
of PowerPivot Data Model, 216-217
of PowerPivot with Excel Pro Plus, 217
BLANK(), 237
blank cells, 300
eliminating in data sources, 20
filling
in data area, 307
in row area, 307
replacing with zeros, 49-50
why one blank cell causes a count, 63-64
blank lines, controlling, 56-59
blog posts, embedding workbooks, 189-191
buttons, pivot field buttons, 137

C
CALCULATE, 252
DAX (Data Analysis Expressions), 242-243
calculated data fields, 329-330
calculated fields, 113-114
creating, 116-120
creating with formulas outside your pivot table, 115
DAX (Data Analysis Expressions) defining, 239-241
filters, 239
inserting into pivot tables, 116
manually adding to data sources, 114-115
order of operator precedence, 128-129
rules for, 129-131
**calculated items, 113-114, 300-330**
changing solve order of calculated items, 133
creating, 124-127
order of operator precedence, 128-129
rules for, 131
**calculated measures, OLAP pivot tables, 204-208**
**calculated members, OLAP pivot tables, 208-210**
**calculating pivot tables, 326**
addressing issues with two or more data fields, 326-327
calculated data fields, 329
calculated items, 300-330
calculations, 327-329
groups, 332-333
Show Values As tab, 333-334
**Calculation option, 333-334**
**calculations**
adding to OLAP pivot tables, 204
calculated measures, 204-208
calculated members, 208-210
cell references, 129
changing in Power View, 274-275
changing in value fields, 67-69
displaying change from previous fields, 72
showing percentage of total, 70
showing rank, 70-71
tracking % of Parent Item, 72
tracking relative importance with Index option, 73
tracking Running Total and % of Running Total, 71-72
use % Of, 70
changing solve order of calculated items, 133
constants, 129
DAX (Data Analysis Expressions), for calculated columns, 237
deleting, 132
documenting formulas, 133-134
editing, 132
managing OLAP, 210-211
named ranges, 129
order of operator precedence, 128-129
referencing totals, 129
worksheet functions, 129
**calendar tables, DAX (Data Analysis Expressions), 246-247**
adding data to PowerPivot, 247-248
**Card View, Power View, 274-275**
case studies
Analyzing Activity by Market, 38
Calculate Range of Prices for a Product, 244-245
Cleaning Up Data for Pivot Table Analysis, 21-22
Converting a Pivot Table to Values, 56
Creating a Data Model with Multiple External Data Tables, 181-184
Creating a Report Showing Invoice Frequency and Revenue Distribution by Product, 142-144
Grouping Text Fields for Redistricting, 81-83
Life After Pivot Tables, 5-7
Life Before Pivot Tables, 3-4
Showing Top Customer, but Total Revenue, 224-225
Summarizing Next Year’s Forecast, 120-124
Synchronizing Two Pivot Tables with One Combo Box, 290-294
**cell references, calculations, 129**
cells, inserting/deleting cells, 308
change in previous fields, displaying, 72
Change PivotTable Data Source dialog, 39
changes, keeping up with changes in data sources, 38-39
changing
calculations, Power View, 274-275
calculations in a value field, 67-69
displaying change from previous fields, 72
showing percentage of total, 70
showing rank, 70-71
tracking % of Parent Item, 72
tracking relative importance with Index option, 73
tracking Running Total and % of Running Total, 71-72
use % Of, 70
default number format, 318-319
field names, 50-51
solve order of calculated items, 133
summary calculations, 63
functions, 64-65
chart points, Power View, 268
charts
adding drill-down to, Power View, 267-268
converting from tables, Power View, 265-267
replicating in Power View, 273
scatter charts, animating over time, 276
check boxes, filters, 95
CHOOSE, 237
cleaning up data for pivot table analysis, 21-22
ClearAllFilters, 345
clearing filters, 345
Code window, Visual Basic Editor, 298
Collie, Rob, 384
column calculations, RELATED(), 238
Column field, multiple consolidation ranges pivot table, 163
column fields, filters, 95
check boxes, 95
Date Filters, 102-103
Label Filters, 97-99
Report Filter area, 103
search boxes, 96-97
Top 10 filter, 100-101
Values columns, 99-100
columns, avoiding repeating groups, 19
columns area, pivot tables, 13-14
combination layouts, PowerPivot, 258
combining non-column-oriented fields, into one dimension field, 371-372
combo boxes, synchronizing pivot tables, 290-294
Compact form, 52-53
comparing tables using pivot tables, 368-369
compatibility, pivot tables, 15-16
Compatibility Checker, 16
conceptual filters, 345-347
conditional formatting
creating custom rules, 152-156
pivot tables, 149-151
removing, 151
connecting to OLAP cubes, 194-196
Const strFieldName, 380
Const strTriggerRange, 380
constants, calculations, 129
controlling totals, 308-309
Controls group, 284
Convert option, 16
converting
pivot tables to values, 56
tables to charts, Power View, 265-267
copying pivot tables as values to new workbooks, 320-321
cosmetic changes, 46
changing field names, 50-51
changing number format to add thousands separators, 47-49
replacing blanks with zeros, 49-50
table styles, restoring gridlines, 46-47
Count, 64, 327-328
Count Distinct, 216, 274-275, 328
Count Nums, 64
Create PivotTable dialog, 220
cube functions, breaking out of pivot table mold, 202-203
CurrentPage property, 340
custom lists, sorting, 92-93
PowerPivot, 248-249
customers, sorting high-to-low sequence based on revenue, 87-90
customizing
pivot tables, 45
adding/removing subtotals, 65-67
appearance, 59-62
changing summary calculations, 63-65
cosmetic changes. See cosmetic changes
report layout changes. See report layout changes
styles, 60-62
dashboards, Power View, 264-265
creating, 263-264
data
external data, 157
merging from multiple tables, PowerPivot, 215-216
preparing for pivot table reporting, 17-18
applying type formatting to fields, 20
avoiding repeating groups as columns, 19
avoiding storing data in headings, 18-19
eliminating gaps and blank cells in your data source, 20
ensuring data is in tabular layout, 18
good data source design, 20
preparing for Power View, 261-263
showing on a map, Power View, 273-274
Data Analysis Lens, 2
data area, filling blank cells, 307
Data Connection Wizard, 194-195
data fields, placement in pivot tables and pivot charts, 139-141
data items, sorting in a unique order, 361
Data Model, 165, 218
adding new tables, 170-171
adding tables, 220
creating, 165-169
new pivot tables, 173-174
creating with external data tables, 181-184
defining relationships, 221-222
Distinct Count, 226-228
Excel 2013, 352
adding model fields, 353-354
adding numeric fields to Values area, 354-355
adding tables to, 352-353
defining pivot cache and building pivot table, 353
putting it all together, 355-357
relationships, 353
limitations of internal Data Model, 174
pivot tables, creating new, 226-227
QuickExplore, 223-226
relationships, 169-170
removing tables, 172
data ranges, automatically expanding data ranges, creating, 367-368
data sets
exploding to different tables, pivot tables, 378-379
transposing with pivot tables, 371-374
data sources
adding calculated fields, manually, 114-115
creating pivot tables with external data sources, 175
Microsoft Access, 175-178
SQL Server, 178-181
keeping up with changes, 38-39
date fields, grouping, 76-77
by week, 78-79
Date Filters, 102-103, 345
Date timeline filter, 94
DATEADD, 252
DATEDIF, 237
dates, filtering timelines, 108-109
DAX (Data Analysis Expressions), 237
CALCULATE, 242-243
calculated fields
  defining, 239-241
  filters, 239
calculations for calculated columns, 237
calendar tables, 246-247
  adding data to PowerPivot, 247-248
creating calculated fields in pivot tables, 238
  RELATED(), 238
DAX calculated fields, adding fields to Values area, 244-246
DAX Formula language, PowerPivot, 216
default number format, changing, 318-319
deleting
  calculations, 132
  cells, 308
  source data tab, 367
  underlying pivot tables, 146
designing workbooks, as interactive web pages, 186-188
Developer tab, 282
displaying change in previous fields, 72
Distinct Count, Data Model, 226-228
distributing pictures of pivot charts, 146
docking, PivotTable Fields list, 85
document themes, 62
documenting formulas, 133-134
drag-and-drop, 29
drill-down, adding to charts, Power View, 267-268
driving multiple pivot tables from one set of slicers, 109-111

E
editing calculations, 132
elements, beginning new (Power View), 268
eliminating
  blank cells, reports showing revenue by category, 317-318
  gaps and blank cells in data sources, 20
embedding, workbooks in blog posts or web pages, 189-191
empty cells, filling, 362-364
enabling VBA (Visual Basic for Applications), 295-296
End With, VBA (Visual Basic for Applications), 301
End+Down, 300
End+Up, 300
equal sign (=), 364
Excel 2007, 302
Excel 2010, 302
Excel 2013
  Data Model, 352
    adding model fields, 353-354
    adding numeric fields to Values area, 354-355
    adding tables to, 352-353
    defining pivot cache and building pivot table, 353
    putting it all together, 355-357
    relationships, 353
joining multiple tables, 218
preparing data, 219-220
PowerPivot Data Model, 302

Excel 2013 Pro Plus, PowerPivot add-in, 228-229
adding calculated columns using DAX, 234-235
data by copying and pasting, 233
data by linking, 233-234
building pivot tables, 235-236
enabling PowerPivot, 229
importing text files, 229-233
relationships, 234

Excel 97-2003 Workbook, 297
Excel Binary Workbook, 296
Excel Macro-Enabled Workbook, 296
Excel Pro Plus, PowerPivot, 217

Existing Connections dialog, 173
expanding data ranges, creating, 367-368
exploding data sets
to different tabs, 378-379
to different workbooks, 379-381

external data, 157
external data sources, creating pivot tables, 175
Microsoft Access, 175-178
SQL Server, 178-181

file formats, macros, VBA (Visual Basic for Applications), 296-297

filtering
charts, with tile boxes (Power View), 271-272
multiple items, 344-345
pivot tables, 94-95
record sets, ShowDetail, 338-340
slicers, 106-108
timelines, 106-108
by date, 108-109

filters, 94
calculated fields, DAX (Data Analysis Expressions), 239
choosing multiple items from Report filters, 104
choosing one item from, 104

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

Filter pane, Power View, 269-271

file formats, macros, VBA (Visual Basic for Applications), 296-297
filtering
charts, with tile boxes (Power View), 271-272
multiple items, 344-345
pivot tables, 94-95
record sets, ShowDetail, 338-340
slicers, 106-108
timelines, 106-108
by date, 108-109

filters, 94
calculated fields, DAX (Data Analysis Expressions), 239
choosing multiple items from Report filters, 104
choosing one item from, 104

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201

filling
blank cells
in data area, 307
in row area, 307
empty cells left by row fields, 362-364

filter icons, Power View, 265
Filter pane, Power View, 269-271

field names, changing, 50-51
fields, adding
to data area, VBA (Visual Basic for Applications), 304-305
to Filters area, 103
to reports, 25-27
to Values area (DAX calculated fields), 244-246

Field List, scatter charts, 276
file extensions, offline cubes, 201
search filter, 346-347
setting up slicers as, 349-351
types of, 347
value filters, 345
Filters area, 103
pivot tables, 14
finding PivotTable Field List dialog, 24
forcing
pivot tables, to refresh automatically, 359-360
two number formats in pivot tables, 374-376
forecasts, summarizing, 120-124
form controls, creating user interfaces, 284-286
formatting
conditional formatting, 149-151
creating custom rules, 152-156
removing, 151
data to PowerPivot, 247-248
pivot charts, limitations of, 141
pivot tables, VBA (Visual Basic for Applications), 305-307
reports showing revenue by category, 321
formulas, documenting, 133-134
FREQUENCY, 376
frequency distribution, creating with pivot tables, 376
functions, summary calculations, 64-65

G

Gainer, Dave, 384
gaps, eliminating in data sources, 20
GeoFlow, 277-280
GETPIVOTDATA, 217
GetPivotData, 384, 388-389
building ugly pivot tables, 390-393
preventing by typing the formula, 387
shell reports
building, 393-394
populating, 395-398
solving pivot table annoyances, 389-390
turning off, 384-386, 387-388
updating reports, 398-399
Go To Special, 364
Grand Totals, controlling, 56-59
gridlines, applying table styles, 46-47
grouping
daily dates up to yearly dates, 316
date fields, 76-77
by week, 78-79
including years when grouping by month, 77-78
numeric fields, 79-80
pivot fields, 76
text fields for redistricting, 81-83
ungrouping, 79
by weeks, 316
Grouping dialog, 80, 376
groups, calculating pivot tables, 332-333

H

hard data, turning pivot tables into, 361-362
hard values, 145

I

Icon Sets, 155
images
Card View, 274-275
Table View, 274-275
importance, tracking with Index option, 73
importing text files, PowerPivot (Excel 2013 Pro Plus), 229-233
Index option, tracking relative importance, 73
of pivot tables, VBA (Visual Basic for Applications), 307-312
of PowerPivot Data Model, 217-218
links, sharing to web workbooks, 188-189
listings
Code That Creates a New Workbook per Region, 342-344
Code That Produces the Category Report in Figure 13.15, 323-325
Code to Create a Data Model Pivot Table, 355-357
Code to Generate a Pivot Table, 306-307
Code to Produce a Static Summary from a Pivot Table, 311-312
Code Used to Create a Report for Each of the Top Three Customers, 339-340
Code Used to Create the Top 5 Markets Report, 336-338

M
macro recorder, VBA (Visual Basic for Applications), 298-299
macros, 281
altering recorded macros, 286-290
file formats, VBA (Visual Basic for Applications), 296-297
recording, 282-283
security, 283
Manage Calculations dialog, 211
managing OLAP calculations, 210-211
manual sort sequence, 91-92
maps
animating pivot table data on maps, 277-280
showing data on, Power View, 273-274
Market filter, 94
Matrix, Power View, 274
Max, 64
MDX (Multidimensional Expressions), 205

Insert Calculated Item dialog, 125
Insert Timelines dialog, 35-36, 143
inserting
calculated fields into pivot tables, 116
cells, 308
interactive web pages, designing workbooks as, 186-188
interfaces, creating with form controls, 284-286
items, filtering multiple items in a PivotField, 344-345

J
joining multiple tables using Data Model in regular Excel 2013, 218
adding tables, 220
preparing data, 219-220

K
KPIs (key performance indicators), PowerPivot, 255
setting up KPI compared to absolute value, 255-257
setting up KPI compared to calculated target values, 256-257

L
Label Filters, 97-99
label filters, 345
layers, adding to pivot tables, 27
layout
combination layouts, PowerPivot, 258
Compact form, 52-53
Outline Form layout, 53-54
limitations
of internal Data Model, 174
of OLAP pivot tables, 197-198
of pivot charts, formatting, 141
of pivot table reports, 15
of pivot tables, VBA (Visual Basic for Applications), 307-312
of PowerPivot Data Model, 217-218
links, sharing to web workbooks, 188-189
listings
Code That Creates a New Workbook per Region, 342-344
Code That Produces the Category Report in Figure 13.15, 323-325
Code to Create a Data Model Pivot Table, 355-357
Code to Generate a Pivot Table, 306-307
Code to Produce a Static Summary from a Pivot Table, 311-312
Code Used to Create a Report for Each of the Top Three Customers, 339-340
Code Used to Create the Top 5 Markets Report, 336-338

M
macro recorder, VBA (Visual Basic for Applications), 298-299
macros, 281
altering recorded macros, 286-290
file formats, VBA (Visual Basic for Applications), 296-297
recording, 282-283
security, 283
Manage Calculations dialog, 211
managing OLAP calculations, 210-211
manual sort sequence, 91-92
maps
animating pivot table data on maps, 277-280
showing data on, Power View, 273-274
Market filter, 94
Matrix, Power View, 274
Max, 64
MDX (Multidimensional Expressions), 205
merging data from multiple tables, 
PowerPivot, 215-216
Microsoft Access, creating pivot tables, 
175-178
Microsoft Office, sharing pivot tables with 
other versions, 192
Min, 64
model fields, adding Data Model (Excel 
2013), 353-354
modifying styles, with document themes, 
62
months, including years when grouping by 
month, 77-78
Multidimensional Expressions (MDX), 205
multiple consolidation pivot tables, creat-
ing, 158-162
Multiple Consolidation Ranges, 158
multiple consolidation ranges pivot table, 
163
  Column field, 163
  creating, 372
  Page fields, 164-165
  Row field, 163
  Value field, 164
multiple ranges, 157

N
.Name, 328
named ranges, calculations, 129
naming conventions, 262
new features, 2
non-column-oriented fields, combining 
into one dimension field, 371-372
number format
  changing to add thousands separators, 
  47-49
  forcing two number formats in pivot 
tables, 374-376
numeric fields
  adding to Values area, Data Model 
  (Excel 2013), 354-355
  grouping, 79-80

O
object variables, VBA (Visual Basic for 
Applications), 300-301
object-oriented code, VBA (Visual Basic for 
Applications), 299
Office, sharing pivot tables with other ver-
sions of, 192
Office 365, 185
offline cubes
  creating, 199-202
  file extensions, 201
OLAP (Online Analytical Processing), 
193-194
  breaking out of pivot table mold with 
cube functions, 202-203
  managing calculations, 210-211
  What-If analysis, 211-212
OLAP cubes
  connecting to, 194-196
  creating offline cubes, 199-202
  structure of, 197-198
OLAP pivot tables
  adding calculations to, 204
    calculated measures, 204-208
    calculated members, 208-210
  limitations of, 197-198
Online Analytical Processing. See OLAP 
(Online Analytical Processing)
order of operator precedence
  calculated fields, 128-129
  calculated items, 128-129
Outline Form layout, 53-54
overriding filters, 252-253, 261-263

P
page breaks, adding subtotals, 322-323
Page fields, multiple consolidation ranges 
pivot table, 164-165
Page Filters, 94
PageFields parameter, 340
pivot tables, 12

animating data on maps, 277-280
AutoShow, executive overviews, 336-338
behind the scenes, 14-15
breaking out of the mold with cube functions, 202-203
building in VBA, 302-304
adding fields to data area, 304-305
building with PowerPivot add-in, 235-236
calculated fields, DAX (Data Analysis Expressions), 238
calculating, 326
addressing issues with two or more data fields, 326-327

calculated data fields, 329-330
calculated items, 330
calculations, 327-329
groups, 332-333
Show Values As tab, 333-334
columns area, 13-14
comparing tables, 368-369
compatibility, 15-16
conditional formatting, 149-151
converting to values, 56
creating
from Data Model, 226-227
new with Data Model, 173-174
with PowerPivot, 249-250
creating basic pivot tables, 22-24
adding fields to reports, 25-27
adding layers, 27
rearranging, 28
report filters, 29-30
creating reports for each region or model, 340-344
creating reports showing revenue by category, 312-315
adding subtotals to get page breaks, 322-323
changing default number format, 318-319
controlling sort order with AutoSort, 318
copying finished pivot tables as values to a new workbook, 320-321
eliminating blank cells, 317-318
formatting, 321
putting it all together, 323-326
rolling daily dates up to years, 315-317
suppressing subtotals for multiple row fields, 319-320
table layout, 315
creating with external sources, 175
Microsoft Access, 175-178
SQL Server, 178-181
customizing, 45
   adding/removing subtotals, 65-67
appearance, 59-62
changing summary calculations, 63-65
cosmetic changes. See cosmetic changes
report layout changes. See report layout changes
default state, 314-315
defined, 9
deleting underlying pivot tables, 146
determining size of finished pivot tables to convert it to values, 309-311
exploding data sets to different tabs, 378-379
exploding data sets to different workbooks, 379-381
filtering, 94-95
filters area, 14
formatting VBA (Visual Basic for Applications), 305-307
frequency distribution, creating, 376
limitations of VBA (Visual Basic for Applications), 307-312
multiple consolidation pivot tables, creating, 158-162
versus PowerPivot, 236-237
rank number fields, adding, 365-366
rearranging, 28
time intelligence, 251
reasons for using, 10-11
refreshing
   all pivot tables in a workbook at the same time, 360
   automatically, 359-360
rows area, 13
ShowDetail, 338-340
sorting, 87
custom lists, 92-93
customers into high-to-low sequence based on revenue, 87-90
manual sort sequence, 91-92
synchronizing with combo box, 290-294
transposing data sets, 371-374
turning into hard data, 361-362
values area, 12-13
when to use, 11-12
PivotFilters.Add method, 345
PivotLayout Object, 136
PivotTable Field List dialog, 24
PivotTable Field List interface, 26
PivotTable Fields list, 83-87
   Areas section drop-downs, 86-87
docking, 85
rearranging, 85-86
undocking, 85
PivotTable Style Options group, 60
PivotTable Styles gallery, 60
Play axis, 276
Play dimension, 276
populating
   shell reports, with GetPivotData, 395-398
Power View, 261
   adding drill-down to charts, 267-268
alignment, 265
animating pivot table data on maps, 277-280
animating scatter charts over time, 276
beginning new elements, 268
calculations, changing, 274-275
Card View, 274-275
chart points, 268
charts, replicating, 273
converting tables to charts, 265-267
dashboards, 264-265
   creating, 263-264
filter icons, 265
Filter pane, 269-271
preparing data for pivot table reporting, 261-263
showing data on a map, 273-274
slicers, 269
sorting, 265
Table View, 274-275
tile boxes, filtering charts, 271-272
tips for, 277

Power View window, 264
PowerCache, 249

PowerPivot, 215, 218, 384
benefits of, with Excel Pro Plus, 217
combination layouts, 258
creating pivot tables, 249-250
DAX Formula language, 216
KPIs (key performance indicators), 255
setting up KPI compared to absolute value, 255-257
setting up KPI compared to calculated target values, 256-257
merging data from multiple tables, 215-216
versus regular pivot tables, 236-237
relationships, 259
sorting by custom lists, 248-249
SQL Server, 258-259
unlimited rows, 216

PowerPivot add-in, Excel 2013 Pro Plus, 228-229
adding
  calculated columns using DAX, 234-235
  data by copying and pasting, 233
  data by linking, 233-234
  building pivot tables, 235-236
enabling PowerPivot, 229
importing text files, 229-233
relationships, 234

PowerPivot Data Model, 185, 302
benefits of, 216-217
limitations of, 217-218

preparing for pivot table reporting, data, 17-18
applying type formatting to fields, 20
avoiding repeating groups as columns, 19
avoiding storing data in headings, 18-19
eliminating gaps and blank cells in your data source, 20
ensuring data is in tabular layout, 18
good data source design, 20

preventing GetPivotData, by typing the formula, 387
primary keys, 169
Product, 64
Project Explorer, Visual Basic Editor, 297
properties, 299
Properties window, Visual Basic Editor, 298

Q

QuickExplore, Data Model, 223-226

R

ranges, multiple ranges, 157
rank, showing, 70-71
rank number fields, adding, 365-366
rearranging
  pivot tables, 28
time intelligence, 251
  PivotTable Fields list, 85-86
Recommended PivotTables, 30-32
Record Macro dialog, 282, 286
recorded macros, altering, 286-290
recording macros, 282-283
recordsets, filtering ShowDetail, 338-340
redistricting, grouping text fields, 81-83
reducing size of pivot table reports, 366-367
referencing totals, calculations, 129
RefreshAll method, 360
refreshing pivot tables
   all pivot tables in a workbook at the same time, 360
   automatically, 359-360

RELATED(), 238
Related Column (Primary), 169
relationships
   Data Model, 169-170
   Excel 2013, 353
   defining in Data Model, 221-222
   PowerPivot, 259
   PowerPivot add-in, Excel 2013 Pro Plus, 234

removing
   conditional formatting, 151
   subtotals, 65-67
   tables from Data Model, 172

Repeat All Data Items, 363
Repeat Item Labels, 363

replacing blanks with zeros, 49-50

replicating
   charts in Power View, 273
   pivot table reports for each item in a filter, 104-106

Report Filter area, 103
Report Filters, 94, 104

report filters, creating, 29-30

report layout changes, 51-52
   blank lines, 56-59
   Compact form, 52-53
   Grand Totals, 56-59
   Outline Form layout, 53-54
   settings, 56-59
   Tabular layout, 54-55

reports
   creating for each region or model, 340-344
   pivot table reports, 9
   updating GetPivotData, 398-399

reports showing revenue by category, 312-315

adding subtotals to get page breaks, 322-323
changing default number format, 318-319
controlling sort order with AutoSort, 318
copying finished pivot tables as values to a new workbook, 320-321
eliminating blank cells, 317-318
formatting, 321
putting it all together, 323-326
rolling daily dates up to years, 315-317
suppressing subtotals for multiple row fields, 319-320
table layout, 315

rolling daily dates up to years, reports showing revenue by category, 315-317
row area, filling blank cells, 307

row field, multiple consolidation ranges pivot table, 163
row fields
   filling empty cells, 362-364
   filters, 95
      check boxes, 95
      Date Filters, 102-103
      Label Filters, 97-99
      Report Filter area, 103
   search boxes, 96-97
   Top 10 filter, 100-101
   Values columns, 99-100

rows, PowerPivot, 216
rows area, pivot tables, 13
rules
   for calculated fields, 129-131
   for calculated items, 131
   custom conditional formatting rules, 152-156
   for pivot charts, 139-141

Running Total, tracking, 71-72
Salas, Pito, 3

scatter charts, animating over time, 276
scrollbars, adding, 287
search boxes, filters, 96-97
search filter, 346-347
section headings, avoiding storing data in, 18-19
security, macros, 283
Select a Rule Type, 153-154
sets, 75
SharePoint, 185
sharing
  links to web workbooks, 188-189
  pivot cache, 39-40
  pivot tables with other versions of Office, 192
shell reports
  building GetPivotData, 393-394
  populating with GetPivotData, 395-398
Show Pages, 341
Show Value As, 68-69
Show Values As tab, 333-334
ShowDetail, 338-340, 379
showing percentage of total, 70
showing rank, 70-71
size of pivot table reports, reducing, 366-367
SkyDrive, 185-186
SlicerCache, 350-351
SlicerItem, 350
slicers, 32, 75, 192
  creating
    standard slicers, 32-35
    timeline slicer, 35-37
  driving multiple pivot tables from one set of slicers, 109-111
filtering, 106-108
Power View, 269
  setting up to filter, 349-351
solve Order dialog, 133
sorting
  controlling with AutoSort, 318
  by custom lists, PowerPivot, 248-249
  data items in a unique order, 361
  pivot tables, 87
    custom lists, 92-93
    customers into high-to-low sequence based on revenue, 87-90
    manual sort sequence, 91-92
  Power View, 265
source data tab, deleting, 367
SQL Server
  creating pivot tables, 178-181
  PowerPivot, 258-259
SQL Server Analysis Services 2012, 194
standard slicers, creating, 32-35
StdDev, 65
StdDevP, 65
storing data in section headings (avoiding), 18-19
structure of OLAP cubes, 197-198
styles
  customizing, 60-62
  modifying with document themes, 62
subtotals
  adding, 65-67
    to get page breaks, 322-323
    for one field, 66-67
  removing, 65-67
  suppressing
    for multiple row fields, 319-320
    when you have many row fields, 65-66
Sum, 64
SUMIFS, 237
summarizing forecasts, 120-124
summary calculations
  changing, 63
    functions, 64-65
    why one blank cell causes a count, 63-64
suppressing subtotals
for multiple row fields, 319-320
when you have many row fields, 65-66
synchronizing pivot tables with combo box, 290-294

T

table layout, reports showing revenue by category, 315
table styles, restoring gridlines, 46-47
Table View, Power View, 274-275
tables
adding
to Data Model, 170-171, 220-222
to Data Model (Excel 2013), 352-353
comparing using pivot tables, 368-369
converting to charts, Power View, 265-267
joining using Data Model in Excel 2013, 218
preparing data, 219-220
Power View, dashboards, 264-265
removing from Data Model, 172
Tabular layout, 54-55
preparing data for pivot table reporting, 18
TEXT, 237
text fields, grouping for redistricting, 81-83
text files, importing PowerPivot (Excel 2013 Pro Plus), 229-233
themes, document themes, 62
thousands separators, adding, 47-49
thumbnails, 2
tile boxes, filtering charts (Power View), 271-272
time intelligence, 251-254
rearranging pivot tables, 251
timeline slicer, 2
creating, 35-37
timelines, 75
filtering, 106-108
by date, 108-109
tools, Visual Basic, 298
Top 10 filter, 100-101
totals, controlling, 308-309
tracking
% of Parent Item, 72
relative importance with Index option, 73
Running Total, 71-72
tracking Running Total and % of Running Total, 71-72
transposing data sets with pivot tables, 371-374
turning off GetPivotData, 384-388
turning pivot tables into hard data, 361-362
type formatting, applying to fields, 20
U
undocking, PivotTable Fields list, 85
ungrouping, 79
updating reports, GetPivotData, 398-399
user interfaces, creating with form controls, 284-286
V
value fields
changing calculations, 67-69
displaying change from previous fields, 72
showing percentage of total, 70
showing rank, 70-71
tracking % of Parent Item, 72
tracking relative importance with Index option, 73
tracking Running Total and % of Running Total, 71-72
use % Of, 70
multiple consolidation ranges pivot table, 164
value filters, 345
values, converting pivot tables to, 56
Values area
  adding fields to reports, DAX calculated fields, 244-246
  adding numeric fields to, Data Model (Excel 2013), 354-355
values area, pivot tables, 12-13
Values columns, filters, 99-100
Var, 65
Variable Cost Next Year field, 123
VarP, 65
VBA (Visual Basic for Applications), 295
  building pivot tables, 302-304
    adding fields to data area, 304-305
    enabling, 295-296
  End With, 301
  Exploding data sets to different workbooks, 379
file formats, macros, 296-297
macro recorder, 298-299
object variables, 300-301
object-oriented code, 299
pivot tables
  formatting, 305-307
    limitations of, 307-312
totals, controlling, 308-309
versions, 301-302
With, 301
writing code to handle any size data range, 299-300
versions, VBA (Visual Basic for Applications), 301-302
VertiPaq, 216
Visual Basic Editor, 297-298
Visual Basic for Applications. See VBA
Visual Basic, tools, 298
VLOOKUP, 219, 237

W
web pages
designing workbooks as, 186-188
embedding workbooks, 189-191
web workbooks, sharing links to, 188-189
What-If analysis, OLAP data, 211-212
With, VBA (Visual Basic for Applications), 301
workbooks
copying pivot tables as values to, 320-321
designing as interactive web pages, 186-188
embedding in blog posts or web pages, 189-191
exploding data sets to, 379-381
refreshing all pivot tables at the same time, 360
sharing links to web workbooks, 188-189
worksheet functions, calculations, 129
writing code to handle any size data range, VBA (Visual Basic for Applications), 299-300

X-Y-Z
xlAfter, 347
xlAfterOrEqualTo, 347
xlAverage, 327
xlBefore, 347
xlBeforeOrEqualTo, 347
xlCaptionContains filter, 349
xlCount, 327
xlCountNums, 327
xlMax, 327
xlMin, 327
xlProduct, 327
xlStDev, 328
xlStDevP, 328
xlSum, 328
xlVar, 328
xlVarP, 328